
Event Notification ModuleTM

Configuration Guide
Version 8.2

63220-083-04A2
04/2014



Event Notification Module 63220-083-04A2
04/2014

© 2014 Schneider Electric. All Rights Reserved.2

Notices

StruxureWare, PowerLogic, Citect, and Schneider Electric are either 
trademarks or registered trademarks of Schneider Electric in France, the 
USA, and other countries. All other trademarks are property of their 
respective owners.



63220-083-04A2 
04/2014

© 2014 Schneider Electric. All Rights Reserved. 3

Safety Information

Important Information
Read these instructions carefully and look at the equipment to become 
familiar with the device before trying to install, operate, service or 
maintain it. The following special messages may appear throughout 
this manual or on the equipment to warn of potential hazards or to call 
attention to information that clarifies or simplifies a procedure.

The addition of either symbol to a “Danger” or “Warning” safety label 
indicates that an electrical hazard exists which will result in personal injury if 
the instructions are not followed.

This is the safety alert symbol. It is used to alert you to potential personal 
injury hazards. Obey all safety messages that follow this symbol to avoid 
possible injury or death.

Please Note
Electrical equipment should be installed, operated, serviced and maintained 
only by qualified personnel. No responsibility is assumed by 
Schneider Electric for any consequences arising out of the use of this 
material.

A qualified person is one who has skills and knowledge related to the 
construction, installation, and operation of electrical equipment and has 
received safety training to recognize and avoid the hazards involved.

DANGER
DANGER indicates an imminently hazardous situation which, if not 
avoided, will result in death or serious injury.

WARNING
WARNING indicates a potentially hazardous situation which, if not 
avoided, can result in death or serious injury.

CAUTION
CAUTION indicates a potentially hazardous situation which, if not 
avoided, can result in minor or moderate injury.

NOTICE, is used to address practices not related to physical injury. The 
safety alert symbol shall not be used with this signal word.
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Safety Precautions

WARNING
 

HAZARD OF INCORRECT INFORMATION
• Do not incorrectly configure the software, as this can lead to incorrect 

reports and/or data results.
• Do not base your maintenance or service actions solely on messages 

and information displayed by the software.
• Do not rely solely on software messages and reports to determine if the 

system is functioning correctly or meeting all applicable standards and 
requirements.

• Consider the implications of unanticipated transmission delays or 
failures of communications links.

Failure to follow these instructions can result in death, serious 
injury, or equipment damage.



63220-083-04A2 Table of Contents
04/2014

© 2014 Schneider Electric All Rights Reserved 5

CHAPTER 1 - OVERVIEW Technical Considerations ............................................................................ 7

CHAPTER 2 - SETTING UP 
EVENT NOTIFICATION 
MODULE

Add Local Users to Event Notification Module Groups ............................... 9
Set Up Local Users .................................................................................. 9
Assign Local Users to a Group .............................................................. 10

Start Event Notification Module Configuration .......................................... 10
Select OPC Servers to Configure ............................................................. 11

Refresh Tags ......................................................................................... 11
Tag Filters ................................................................................................. 11

Copying a Tag Filter .............................................................................. 14
Recipients ................................................................................................. 15

Removing a Recipient ............................................................................ 16
Delivery Relays ......................................................................................... 16

Define Messages For Relay Notifications (Optional) ............................. 17
Copying Delivery Relay Settings From One Recipient to Another ......... 17

Schedules ................................................................................................. 19
Copying a Schedule From One Recipient to Another ............................ 20

Subscriptions ............................................................................................. 20
Services .................................................................................................... 21
Maintenance Control ................................................................................. 22

CHAPTER 3 - RESOLVE 
ISSUES

Problems and Resolutions ........................................................................ 23

CHAPTER 4 - RELAY 
ATTRIBUTE DEFINITIONS

Definitions ................................................................................................. 25
Attributes ................................................................................................... 25

CHAPTER 5 - OPC AE SERVER 
FOR PLSCADA

Installation ................................................................................................. 29
Citect Configuration ................................................................................... 29

CHAPTER 6 - DATABASE 
MAINTENANCE UTILITY

SQL Scripts and Windows Tasks .............................................................. 31

CHAPTER 7 - HOT STANDBY 
CONFIGURATION

Prerequisites ............................................................................................. 33
Hot Standby Tool ...................................................................................... 33
Configure ENM on the Primary Server ...................................................... 34
Configure ENM on the Secondary Server ................................................. 35
Configure PLSCADA Servers for Hot Standby Operation ......................... 36

Share server folders .............................................................................. 36
Configuring PLS 7.2 Servers for Hot Standby Operation ...................... 37
Configure Citect Software ...................................................................... 40
Configuring PSE 7.30/7.40 Servers for Hot Standby Operation ............ 43

Troubleshooting ........................................................................................ 48
Troubleshooting Citect Setup ................................................................ 48
Active and Passive Cycling Messages in ENM Diagnostic Log ............. 49

CHAPTER 8 - CUSTOM 
MESSAGING

Standard OPC attributes ........................................................................ 51
Custom OPC attributes .......................................................................... 51

CHAPTER 9 - DCOM 
CONFIGURATION

Setting Up a Remote Machine ............................................................... 53
Set the COM Security Options ............................................................... 54
Access Permissions ............................................................................... 56
Configure Firewall Settings .................................................................... 57



Table of Contents  63220-083-04A2
04/2014

© 2014 Schneider Electric All Rights Reserved6



63220-083-04A2 
04/2014

© 2014 Schneider Electric All Rights Reserved 7

Chapter 1 — Overview

NOTE: Other parts of the overall communication system, such as email servers and cellular 
phone systems, could fail and result in notifications not being delivered. If notifications are not 
delivered to recipients, conditions that cause alarming may persist and result in safety critical 
issues.

The Event Notification Module (ENM) provides a way for you to make sure the specified 
people in your facility are notified about critical power incidents no matter where they are. 
ENM delivers timely alerts of power system events to the mobile phone, email or pager of 
designated users and helps them quickly identify system abnormalities and take appropriate 
action.

Event Notification Module provides:

• Flexible alarm notifications schedules
• Multiple notification options
• Alarm grouping
• Alarm consolidation
• Simple commissioning 
• Maintenance mode

Technical Considerations

The core function of the ENM is alarm notification. ENM accepts alarms through OPC Alarm 
and Event (AE) servers and PowerLogic™ SCADA servers and notifies the specified user 
based on the configured notification options and alarm schedule.

ENM also includes the Alarm Sentry component. Alarm Sentry extends the standard 
notification features of ENM with alarm evaluation capabilities. Alarm Sentry can generate 
alarms on data from a StruxureWare™ Power Monitoring Expert System. Alarm Sentry 

WARNING
 

HAZARD OF UNDELIVERED NOTIFICATIONS
Do not rely solely on Event Notification Module software for alarm notifications where 
human or equipment safety relies on successfully delivered notifications.

Failure to follow these instructions can result in death, serious injury, or equipment 
damage.

WARNING
 

HAZARD OF UNINTENDED OPERATION
Do not use Event Notification Module software for critical control or protection applications 
where human or equipment safety relies on the operation of the control circuit.

Failure to follow these instructions can result in death, serious injury, or equipment 
damage.
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accepts data through an OPC Data Acquisition (DA) server and evaluates the alarm 
conditions. If an alarm occurs, Alarm Sentry passes the event to the ENM notification engine.

The following chapters explain how to configure the core ENM features and OPC Server 
components. Each of these components plays an important part in providing a complete 
alarm evaluation and notification solution.

For more information on the Event Notification Module and Alarm Sentry, refer to:

• Alarm Sentry Configuration Guide, 63220-083-05
• Event Notification Module Monitoring and Diagnostics User Guide, 63220-083-06
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Chapter 2 — Setting up Event Notification Module

This chapter describes how to set up Event Notification Module (ENM) to receive alarms and 
events and to transmit them to recipients via email, SMS text messages, and other methods.

The setup of ENM involves the following tasks.

1. Add local users to ENM groups.
2. Start the ENM web setup application.
3. Set up OPC alarm and event server connections.
4. Configure alarm and event filtering from various OPC alarm and event servers.
5. Identify recipients and how they should be notified.
6. Define the schedule for each recipient to receive alarm messages.
7. Subscribe recipients to receive alarm notifications.
ENM Services must be restarted from the Services tab before configuration changes take 
effect (tasks 4–7). Refer to “Services” on page 21 for more information.

Add Local Users to Event Notification Module Groups

The following sections explain how to set up the necessary ENM user groups. The following 
table lists the access rights to the applications for each user group.

NOTE: Only ENM Administrators have access to the Configuration page. To configure an 
ENM application, administrative privileges must be established by adding the user to the 
ENMAdmin group.

NOTE: This section explains how to set up local users only.

Set Up Local Users

Use Computer Management to add new users for ENM.

1. In Windows Control Panel, open Administrative Tools > Computer Management. The 
Computer Management screen appears.

2. In the Computer Management tree view, click System Tools > Local Users & Groups. 
The Users and Groups folder appear in the tree view.

User Group Application Access

ENMAdmin
ENM Configuration All tabs
Alarm Sentry All tabs
Monitoring and Diagnostics All tabs

ENMControl
ENM Configuration Maintenance tab only
Alarm Sentry No access
Monitoring and Diagnostics All tabs

ENMUser
ENM Configuration No access
Alarm Sentry No access
Monitoring and Diagnostics All tabs
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3. Right-click the Users folder and select the New User command. The New User screen 
appears. 

4. Enter the User Name, Full Name, and Description. 
5. Enter the user’s password. 
6. Click Create, and then click Close. 

Assign Local Users to a Group

After you add a local user to the system, you can assign the user to either ENMAdmin, 
ENMControl, or ENMUser account. The same user can be assigned to all three accounts.

1. In the Computer Management tree view, click Groups folder. The system group names 
appear in the list. 

2. Double-click either ENM group to assign local user to that group. The group Properties 
screen appears.

3. Click Add.
4. Type in the user’s name that you want to add to this group and find it.
5. Click OK. The group Properties screen appears.
6. Click Apply, and then click OK.

NOTE: For these changes to take effect, the users who were granted permissions must 
log out and log back in to Windows. If using remote desktop, closing the session and 
re-opening is not sufficient.

Start Event Notification Module Configuration

If the Event Notification Module Configuration page is not open, then open it as follows.

In Windows, go to Start > All Programs > Schneider Electric > StruxureWare Solutions > 
ENM Configuration. You can also use the Desktop shortcut icon. 

The Event Notification Module Configuration page appears.
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Select OPC Servers to Configure

On the OPC Servers tab, you select the OPC servers to subscribe to. To select the OPC 
servers to subscribe to:

1. Click the OPC Servers tab.
2. Enter the Host Machine Name or IP Address of the OPC server host machine.

NOTE: OPC servers on “localhost” will be auto-detected.

3. Click Detect OPC Servers.
The OPC servers that are detected are listed.

4. Select the OPC server(s) to subscribe to.
5. Click Save and Refresh Tags.

Refresh Tags

To obtain the most current tags from an OPC server, click Refresh Tags. Be aware that it 
can take several minutes for the refresh to complete.

Tag Filters

To streamline alarm notification configuration, ENM provides logic for grouping tag names 
together into a “Tag Filter.” To complete configuration of ENM, at least one Tag Filter must be 
defined and contain at least one Tag Name.
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To set up Tag Filters:

1. Click the Tag Filters tab.
2. Choose an OPC Server.

3. Click Add Filter.

4. On the Details tab, enter the following:
• Tag Filter Name. Enter a descriptive name.
• Severity (also sometimes referred to as Priority). Enter the severity range of alarms 

and events to be captured for notification.
NOTE: If you are unfamiliar with alarm severity levels, contact your system administrator 
for information.

• (Optional) To avoid receiving hundreds of alarms in a few seconds, you can aggregate 
all alarms occurring within a specified number of seconds into one message. For 
example, entering “120” into the Compression field combines all alarms occurring in 
a two minute (120 second) period into two messages. The first message notifies you 
that compression has begun. Then after the compression period, you will receive a 
message containing information on alarms that occurred during the compression 
period.
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• (Optional) In the Compression Message field, enter any additional message you 
want to include in the notifications you receive when messages have been 
compressed.

5. Click the Tags tab and select the Tag Name(s) to add to the filter. The Show drop-down 
allows you to choose whether to list all tags, the tags selected, or the unselected tags. 
The Search field is for a “contains” search on the tag names in the list below it. You can 
quickly select/unselect all tag names in the results by clicking the check box next to the 
“Tag Name” header.

6. Click Save Changes.
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Copying a Tag Filter

When setting up tag filters, you can save time by copying one and then modifying it as 
needed for additional tag filters. To copy a tag filter:

1. Click Add Filter and add a tag filter and name it without entering any additional details or 
selecting tags.

2. Click Save Changes.
3. From the Tag Filters list, choose the Tag Filter to be copied.

4. Select the destination Tag Filter from the drop-down and click Copy.
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5. Click Yes.

6. Click Save Changes.

Recipients

On the Recipients tab, you can add and remove recipients who can receive alarm and event 
messages.

1. Click Add Recipient.

2. Enter the name in the Name field under Recipient Details. Add a description if desired.

3. Click Save Changes.
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Removing a Recipient

To remove a recipient:

1. Click the Recipients tab.
2. Select the recipient to be removed and click Remove Recipient.

3. Click Save Changes.

Delivery Relays

On the Delivery Relays tab, set up the method for relaying (delivering) the notifications to 
recipients. For example, you can send notifications to an email address.

To set up a delivery relay for a recipient:

1. Click the Delivery Relays tab.
2. Select the Recipient.
3. Choose the Delivery Relay and edit details including the message you want to send for 

the notification. For this example, we are setting up an email address.

4. Click Save Changes.
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Define Messages For Relay Notifications (Optional)

The attribute “Message” is available in the following relays so you can configure the message 
body of the notification sent to the recipient. 

• Dialup-TAP
• Email
• GSM Out
• Modbus
• SMPP
• SNMP
• SNPP

For the Email relay, you can also configure the subject of the message.

When a new recipient is created the message value defaults to [MESSAGE] which will send 
the OPC message text to the targeted recipient.

For more information about customized messages, refer to  Chapter 8  — Custom 
Messaging on page 51.

Copying Delivery Relay Settings From One Recipient to Another

When setting up recipients with similar delivery relays, you can save time by copying a 
delivery relay and then modifying it as needed for additional recipients. For example, you can 
copy an email delivery relay from one recipient to another.
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To copy a Delivery Relay:

1. Select the originating recipient from the Recipients list and the delivery relay from the 
Delivery Relays list.

2. From the drop-down, choose the destination recipient and click Copy.

3. Click Yes.

4. Click Save Changes.



63220-083-04A2 Chapter 2—Setting up Event Notification Module
04/2014 Schedules

© 2014 Schneider Electric All Rights Reserved 19

Schedules

You can specify the days of the week and the hours of the day when recipients receive 
notifications. To set up a schedule for a recipient:

1. Click the Schedules tab.
2. Select the recipient and click Add Schedule.

3. Select the days and enter Start and End times.

4. To add another schedule with different hours for other days of the week, click Add 
Schedule and set the days and hours. If needed, add a 24-hour “on call” schedule.

5. To set the days and hours when notifications are not sent, such as vacation time, do the 
following:
a. Click Disabled Schedules. Then, click Add Disabled Schedule.

b. Set the days and hours.

6. Click Save Changes.
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Copying a Schedule From One Recipient to Another

When setting up recipients with similar schedules, you can save time by copying a schedule 
and then modifying it as needed for additional recipients.

NOTE: You can only copy active schedules. You cannot copy disabled schedules.

To copy a Schedule:

1. From Recipients, choose the recipient with the schedule to be copied.

2. From the drop-down, choose the recipient who will get the copied schedule and click 
Copy.

3. Click Yes.

4. Edit days and times as needed.
5. Click Save Changes.

Subscriptions

In order for a recipient to receive alarm notifications, you must set up a subscription for that 
recipient. On the Subscriptions tab, you specify which tag filters are assigned to a recipient 
and how those alarms are sent.

To set up subscriptions for a recipient:

1. Click the Subscriptions tab.
2. Select a recipient.
3. Click Add Subscription.
4. In Subscriptions, choose the following:
• OPC Server
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• Tag Filter
• Delivery Relay
• (Optional) Select Health Check if you want ENM to send regular health check 

notifications by the specified delivery relay. The default period of inactivity is one hour. 
If you need to change this, contact Technical Support.

5. Click Save Changes.

If you want to test the delivery relay, click Test.

If you want to remove a subscription, click Remove and Save Changes.

Services

On the Services tab, you can view the current status of services associated with ENM. You 
can also perform a start, stop, and restart of the services individually or click Reset All 
Services to reset all services. To view the most up to date status of the displayed services, 
click Refresh Status.

Services must be restarted before changes to Filters, Recipients, Relays, Schedules, or 
Subscriptions take effect.
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Maintenance Control

ENM allows you to temporarily ignore alarms from specified tag names. Once a tag name is 
placed into maintenance mode, ENM does not forward alarms for that particular tag name via 
any defined Delivery Relay/Filter combinations.

ENM gives you flexibility to select one or more tag names to put into maintenance mode. The 
Search feature allows you to narrow down the list and a selector shows tag names that are 
currently selected or not selected.

To put tag names into maintenance mode:

1. Click the Maintenance Control tab.
2. Select the Tag Name(s) to be put into maintenance mode. The Show drop-down allows 

you to choose whether to list all tags, the tags selected, or the unselected tags. The 
Search field is for a “contains” search on the tag names in the list below it. You can 
quickly select/unselect all tag names in the results by clicking the check box next to the 
“Tag Name” header.

You can use the drop-down to choose whether to show all tags, the tags selected, or the 
tags unselected.

3. Click Save Changes to put the selected tag names into maintenance mode.
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Chapter 3 — Resolve Issues

If symptoms exist and do not match with the ones listed in this chapter, or if the attempt to 
implement the prescribed solution does not resolve the issue, please contact Technical 
Support.

Problems and Resolutions

Problem Resolution

ENM service and the OPCAELogger 
Service do not start after installing ENM.

After installing ENM, you must restart the server. The ENM service and the 
OPCAELogger Service will start automatically after the system restarts. 

The OPC AE Server and ENM application 
are on separate machines, and you are 
having problem connecting to the OPC 
server. 

The configuration of the DCOM settings for the two machines must be corrected. 
Contact Technical Support.

ENM installation restarts after adding a 
new user.

If a new Windows user profile is created after installing ENM, then logging into the 
machine as the new user will cause the ENM install to restart. To avoid this issue, 
create additional local Windows user profiles before installing ENM.

“The page cannot be displayed” message 
appears when accessing the ENM web 
application.

ENM relies on integrated Windows authentication for security. If the IIS setting HTTP 
Keep-Alives Enabled is unchecked for the default website integrated Windows 
authentication does not work and the resulting error message is shown.
To correct the issue, go to the Default Web Site Properties screen, select the Web 
Site tab and check the HTTP Keep-Alives Enabled option. 

Blank screen appears after you click the 
AE Subscription menu link on the Setup 
page. 

When this happens, click on the AE Subscription menu link again.
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Problem Resolution

The names of some filters migrated from 
version 5.x are truncated in ENM filter 
drop-down boxes.

The filter drop-down boxes in ENM are limited to 40 characters, including spaces. 
During migration from version 5.x, 5 characters are appended to the name of the 
filter. If the original filter name is longer than 35 characters, then the filter name is 
truncated in ENM.

The user interface looks skewed or out of 
proportion.

The minimum recommended screen size for ENM is 1024 by 768. Use the Windows 
Monitor Properties page to change the screen size. Otherwise, maximize the browser 
window and refresh the page.

Configuration changes do not take effect 
in the application.

After you change the configuration settings, restart the ENM service and the 
PLOpcAELogger service. To restart the services, use System > Preferences page in 
ENM or the Windows Service Controller in the Control Panel.

In Alarm Sentry, the DA Tag selection 
page is unable to browse the DA Tags.

Open Computer Management and verify the PL AlarmGen Host Service is started.
The PL AlarmGen Host Service allows the web configuration tool to access the 
various OPC DA servers and provides the DA tags available on these servers. In 
order for the configuration tool to function correctly the Host Service must be running 
and accessible to the IIS server running the configuration application.

If the PL Alarm Gen Host Service is started and the problem continues, check the 
firewall configuration, as follows:
The Host Service provides web services which are available on two network ports: 
7897 and 7896. These ports must be opened on any firewall which is installed on the 
server. The Alarm Sentry install process opens these ports as well as port 81 for use 
by the eSolutions website. 
If disabling the firewall corrects the issue, open ports 7897 and 7896 before enabling 
the firewall.
To facilitate opening the correct ports, the following batch files are included in the 
install:
1. EnablePorts_PLES.bat opens the ports for all networks.
2. EnablePorts_PLES.bat opens the port for the subnet only.
3. DisablePorts_PLES.bat closes the ports.

The folder is:
C:\Program Files\Schneider Electric\EventNotificationModule\PLeSolutionsWeb\ 
AlarmGenUI\Services

There are Alarm Sentry issues with 
DCOM configuration.

Refer to  Chapter 9  — DCOM Configuration on page 53.
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Chapter 4 — Relay Attribute Definitions

Definitions

Attributes

Relay Attributes for “Dial-up TAP”: 

Term Description

GSM Global System for Mobile communications. This is a 
communications standard used by many mobile phones. 
SMS is defined in the GSM standard, allowing messages of 
up to 160 characters.

OTA Over-the-Air activation system. his is a category of the type 
of device that is connecting to the SMSC – used in the SMPP 
standard.

PL SMS PowerLogic System Manager Software. 
SIM card Subscriber Identity Module. This is a chip that is placed into a 

mobile phone and securely stores the service-subscriber key 
of a user, allowing the user to switch phones by replacing the 
SIM card. This card is mandatory in all devices that 
communicate using GSM.

SMPP Short Message Peer to Peer. This is an open standard that 
sends and SMS by connecting directly to an SMSC. Often 
used to submit messages in bulk.

SMS Short Message Service. This is a communications protocol 
that allows the exchange of short text messages (160 7-bit 
characters, including spaces) between mobile phones. More 
information about SMS, including other protocols can be 
found at the website www.smsforum.net. 

SMSC Short Message Service Centre. Routes an SMS sent by a 
user, to the specified destination.

SNPP Simple Network Paging Protocol. This is a standard protocol 
for sending messages to SMS and paging devices.

TAP Telocator Alphanumeric Protocol. This protocol can be used 
to send SMS messages using a standard modem and 
telephone landline.

UCP Universal Computer Protocol. This is a protocol that is used 
by mobile phones to connect to an SMSC.

VMS Voice Mail System. This is a category of the type of device 
that is connecting to the SMSC – used in the SMPP 
standard.

Attribute Description

Dialup Device Name of the device for sending ENM messages.
Dialup Speed The baud rate of the communication system.
Data Format The data bits / parity / stop bits. Contact your provider to get 

this. See the ActiveXperts website for more information:
http://www.activexperts.com/xmstoolkit/smsclist/ 
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Relay Attributes for “Email”: 

Protocol Type of provider, either TAP or UCP. 
Password The provider password, if required.
Sender Number The reply-to number in the SMS.
Recipient Number SMS number of the recipient.
Provider Dial String The number to dial for provider access.
Prefix Text Text to append before the message body of the SMS.
Postfix Text Text to append after the message body of the SMS.
Retries The number of unsuccessful send attempts before canceling 

the SMS.
Log File Path The full path, including the file name, of the log file. All device 

commands and responses are written to this file.
Message Defines the message sent out to the recipient. The default 

value is [MESSAGE], which will cause the notification to 
include the OPC Message text. This value can be 
customized as described in “Define Messages For Relay 
Notifications (Optional)” on page 17.

Attribute Description

“From” Appears in the “From” field of the sent email.
“To” Addresses of e-mail recipients, comma separated.
SMTP Server Host This can be a server name or an IP address of the provider. 

Usually obtained from the IT department.
Credential User Name Login for SMTP Server, if required.
Credential Password Password for SMTP Server, if required.
Retries This number determines how many unsuccessful send 

attempts are made before the email is aborted.
Prefix Text Text to append before the subject of the email.
Postfix Text Text to append after the subject of the email.
Enable SSL True or False – indicates whether the email is sent using 

Secure Sockets.
Subject The text that will appear in the subject line of the sent email.
Pickup Directory Location Path to the folder where email messages are to be placed in 

order to be processed by the SMTP server. Blank by default. 
Delivery Method Indicates how email messages are delivered. Blank by 

default. Options include:
• An SMTP server.
• Moving the email into the pickup directory for IIS, which 

then delivers the message.
• Moving the email to a directory specified by 

PickupDirectoryLocation for later delivery by another 
application.

SMTP Service Port An integer that represents the port number on the SMTP 
host. The default value is 25.

SMTP Timeout An integer that specifies the time-out value in seconds. The 
default value is 60 seconds.
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Relay Attributes for “GSMOUT”: 

Relay Attributes for “SMPP”: 

Message Defines the message sent out to the recipient. The default 
value is [MESSAGE], which will cause the notification to 
include the OPC Message text. This value can be 
customized as described in “Define Messages For Relay 
Notifications (Optional)” on page 17.

Attribute Description

Gsm Device Name of the device to use for sending SMS messages.
Gsm Sim Pin Required if SIM card is pin-protected.
Gsm Prefix Text Text to append before the subject of the SMS.
Gsm Postfix Text Text to append after the subject of the SMS.
Gsm Retries This number determines how many unsuccessful send 

attempts are made before the SMS is aborted.
Gsm Recipient SMS number of the recipient.
Log File Path This is the full path (including name) of the log file. All device 

commands and responses are written to this file.
Message Defines the message sent out to the recipient. The default 

value is [MESSAGE], which will cause the notification to 
include the OPC Message text. This value can be 
customized as described in “Define Messages For Relay 
Notifications (Optional)” on page 17.

Attribute Description

Smpp Server This can be a server name or an IP address of the provider.
Smpp Server Port TCP port used for connection to SMPP provider.
Smpp System ID Account used to login to the SMSC provider’s system.
Smpp Password Password used to login to the SMSC provider’s system.
Smpp System Type Type of SMSC provider, such as SMPP, VMS, or OTA.
Smpp Keep Alive (Seconds) Integer representing the number of seconds to keep a 

communication channel open.
Smpp Timeout (Milliseconds) Integer representing the server timeout in milliseconds – 

used for all network operations such as Connect or Send.
Smpp Prefix Text Text to append before the subject of the SMS.
Smpp Postfix Text Text to append after the subject of the SMS.
Smpp Retries This number determines how many unsuccessful send 

attempts are made before the SMS is aborted.
Smpp Recipient SMS number of the recipient.
Log File This is the full path (including name) of the log file. All device 

commands and responses are written to this file.
Message Defines the message sent out to the recipient. The default 

value is [MESSAGE], which will cause the notification to 
include the OPC Message text. This value can be 
customized as described in “Define Messages For Relay 
Notifications (Optional)” on page 17.
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Relay Attributes for “SNMP”: 

Relay Attributes for “SNPP”: 

Relay Attributes for “MODBUS”: 

Attribute Description

Snmp Server This can be a server name or an IP address of the provider. 
Required for the relay to work

Snmp Community This name is used to identify the group of the agent
Snmp Port An integer that represents the port number on the SNMP 

host and the client. The default value is 162.
Snmp Protocol Version This option is not editable and only SNMP v2c is selected
Message Defines the message sent out to the recipient. The default 

value is [MESSAGE], which will cause the notification to 
include the OPC Message text. This value can be 
customized as described in “Define Messages For Relay 
Notifications (Optional)” on page 17.

Attribute Description

Snpp Server This can be a server name or an IP address of the provider.
Snpp Server Port TCP port used for connection to SMPP provider.
Snpp Password Password used to login to the SMSC provider’s system.
Snpp Timeout (Milliseconds) Integer representing the server timeout in milliseconds – 

used for all network operations such as Connect or Send.
Snpp Prefix Text Text to append before the subject of the SMS.
Snpp Postfix Text Text to append after the subject of the SMS.
Snpp Retries This number determines how many unsuccessful send 

attempts are made before the SMS is aborted.
Snpp Recipient SMS number of the recipient.
Log File This is the full path (including name) of the log file. All device 

commands and responses are written to this file.
Message Defines the message sent out to the recipient. The default 

value is [MESSAGE], which will cause the notification to 
include the OPC Message text. This value can be 
customized as described in “Define Messages For Relay 
Notifications (Optional)” on page 17.

Attribute Description

IP Address This is the IP address of the device
Device ID The Modbus/device ID of the device
Register Number Register number to which a value is written
Switch ON Value ON Value to be written to the register
Switch OFF Value OFF Value to be written to the register
Time Duration for OFF 
(Seconds)

Time period for the ON value of the register number to be 
swapped by the OFF number
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Chapter 5 — OPC AE Server for PLSCADA

If you are connecting a PowerLogic SCADA OPC Server to Event Notification Module, read 
this chapter. The PowerLogic SCADA OPC server connects to the PowerLogic SCADA 
server and acts as an OPC-compliant Alarm and Event server.

Installation

The ENM DVD allows for the installation of the PLSCADA OPC Server application. The 
installer package installs the PLSCADA OPC server if PowerLogic SCADA 7.1 is present on 
the machine.

Citect Configuration

The OPC server connects to the installed PowerLogic SCADA server to retrieve events. The 
translation of PLSCADA alarms into OPC events is as follows.

Event Tree

The OPC tree structure is built from the Alarm Tag using a UNC type structure. Each level of 
the tree is defined by a back slash “\” character so that multilevel trees can be defined. For 
example:

Source\Event1

Source\Event2

produces a tree with “Source” as the root and “Event1” and “Event2” as sub-levels:

Source

Event1

Event2

Trees can have as many levels as needed to represent the event structure the customer 
desires.

PowerLogic SCADA Event Priorities

PLSCADA priorities are defined in the Alarm Category Screen. A priority is an integer value 
between 1 and 255. The value 1 is the considered the highest priority while 255 is the lowest. 

PLSCADA OPC server converts these priority values into values consistent with the OPC 
scale where 1 is lowest and 1000 is highest. A PLSCADA priority of 1 is equivalent to OPC 
severity of 1000. A PLSCADA priority of 255 is equivalent to OPC severity of 1.
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Chapter 6 — Database Maintenance Utility

SQL Scripts and Windows Tasks

The Database Maintenance Utility is a set of SQL scripts scheduled to run daily as a 
Windows scheduled task. These scripts and tasks facilitate the maintenance of the various 
databases associated with Event Notification Module (ENM). They are installed during the 
ENM installation.

The scripts associated with the database maintenance tasks are located in the 
DBMaintenance directory. To change the directory for the backup or some other aspect of the 
maintenance tasks, edit the scripts in the subdirectory associated with the particular task.

All tasks associated with the Database maintenance are scheduled to run once per day 
during the early morning hours.

Task Description

Database Backup Performs backup on the databases.
Log Backup Performs a backup of the log files.
Rebuild Index Rebuilds the table indexes.
Reorg Index Reorganizes the table indexes.
ShrinkTranLog Shrinks the transaction log.
TrimDiagnosticLogTable Removes old diagnostic events. By default, this task leaves 

1,000,000 records for diagnostic events. This is the 
maximum recommended value as more than this may cause 
performance degradation. To change the number of records 
to keep, edit the TrimDiagnosticLogTable.sql file.

TrimEventsTable Removes old monitoring events. By default, this task leaves 
2,000,000 records for monitoring events. This is the 
maximum recommended value as more than this may cause 
performance degradation. To change the number of records 
to keep, edit the TrimEventsTable.sql file.
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Chapter 7 — Hot Standby Configuration

In Hot Standby mode, two separate installations of ENM are required on two PLSCADA 
servers, configured to run as redundant servers. Only one ENM server will be active at any 
instance, although both installations will record the alarms from PLSCADA. If the primary 
server becomes unavailable, the second ENM server will take over active paging 
responsibilities. All alarms received by the second ENM server, while the primary server is 
unavailable, will be synchronized as soon as the primary server comes back online.

The following sections describe how to configure the ENM and PLSCADA servers to enable 
Hot Standby mode.

Prerequisites

Complete these steps before you configure ENM to run in “Hot Standby” mode:

1. Install ENM 7.0 or higher on both servers. Refer to Event Notification Installation Guide for 
instructions.

2. Configure all alarm tags in PLSCADA. Refer to PLSCADA documentation for instructions 
to use PLSCADA software.

Hot Standby Tool

Proceed with these steps only after configuring ENM on the Primary machine. This means 
that all OPC servers have been selected and that filters, schedules, recipients, and so forth 
have been configured properly and are working as desired.

Primary

1. Open the Hotstandby Configuration Tool (C:\Program Files\Schneider 
Electric\StruxureWare Solutions\HotStandby/HotStandbyCfg) on the primary 
machine.

2. Enter a valid Local Database Connection.
3. Check Enable Hot Standby.
4. Enter the Primary Server IP address or machine name.
5. Enter the Secondary Server IP address or machine name.
6. Click Apply Changes.
7. Click the Export / Import Settings tab, choose a destination to export the configuration 

file, and click Export Settings.
8. Copy the export file to the secondary server.

Secondary

1. Open the HotStandby Config tool on the secondary machine.
2. Enter a valid Local Database Connection for the secondary machine.
3. Click the Export / Import Settings tab, enter the path for the file you copied, and click 

Import Settings.
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Configure ENM on the Primary Server

1. On the primary server, configure ENM as described in the previous chapters:
• Servers
• Filters
• Relays and recipients
• Scheduling
• Subscriptions

2. Test and verify that the configurations are correct.
3. Start the HotStandby configuration tool: In Windows, go to Start > Program Files > 

Schneider Electric > Event Notification Module > Hot Standby > Hot Standby Config 
UI. The following screen appears.

4. Check the Enable Hot Standby option.
5. Enter the Primary Server and the Secondary Server name or IP address.
6. Click Apply Changes.



63220-083-04A2 Chapter 7—Hot Standby Configuration
04/2014 Configure ENM on the Secondary Server

© 2014 Schneider Electric All Rights Reserved 35

7. Click the Export/Import Settings tab.

8. In the Export File Name box, enter a local folder and file name to export the settings and 
click Export Settings.

NOTE: Do not export the file to a network drive.

Configure ENM on the Secondary Server

1. Copy the Sag04_ENM_Setup.zip or the file which you exported to the local drive from the 
remote server.

2. Close the ENM web application if it is open.
3. Stop the ENM and OPC Logger services using the Windows Control Panel.
4. Start the Hot Standby Configuration tool.
5. Click the Export/Import Settings tab.
6. Select the file in the Import File Name box and click Import Settings.

NOTE: During the import, the Diagnostic Log tab is automatically displayed and all 
progress is shown here. Check if there are any errors indicated here. Most errors 
encountered will be SQL time out errors or SQL access errors. If you do encounter any 
errors, restart the SQL server and import the settings again.

7. Click the HotStandby Configuration tab and click Apply Changes.
8. After successfully importing the settings, start the ENM, OPC Logger and PLHotStandby 

Services using the Windows Control Panel.
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Configure PLSCADA Servers for Hot Standby Operation

Share server folders

1. Share the Folder “PowerLogic SCADA 7.20” on both the servers: Primary and Secondary.
If PLSCADA was installed in the default location, the folder is located at:

C:\Documents and Settings\All Users\Application Data\Schneider Electric\PowerLogic 
SCADA 7.20 

2. On the primary server, map the “PowerLogic SCADA 7.20” folder from the secondary as 
network drive “G”. You can use a different letter if G is already taken.

3. On the secondary server, map the “PowerLogic SCADA 7.20” folder from the primary as 
drive G, if it is available. Use the same drive letter as you selected in step 2.
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Configuring PLS 7.2 Servers for Hot Standby Operation

To ensure proper Hot Standby Operation, base PLS 7.2 projects must have connection 
priorities set for Alarm Servers. Do not enable connection priorities if SR1 or subsequent 
hotfixes have been applied as it may cause Hotstandby to function improperly.

Setting connection priorities

1. In the Citect Project Editor, Click Tools > Computer Setup Editor.



Chapter 7—Hot Standby Configuration  63220-083-04A2
Configure PLSCADA Servers for Hot Standby Operation 04/2014

© 2014 Schneider Electric All Rights Reserved38

2. Expand the Primary or Secondary Alarm Server (depending on whether it is the Primary 
or Secondary machine) and select Priority from the list on the right.
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3. Enter a number to denote the connection priority; the lower the number, the higher the 
priority, with 1 being the default.
NOTE: We recommend that you set that the Primary Alarm Server to 1 and set the 
Secondary to a higher number (and therefore a lower priority) to ensure proper operation 
of Hot Standby.

4. Click File > Save or exit and then exit the window and click Yes when prompted to save 
the file.

5. If the project is running, exit the project and restart it to ensure that the new settings are 
applied.

6. Repeat for the secondary computer.
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Configure Citect Software

Complete the following steps on the primary server and the secondary server. 

1. Start the Citect Project Editor and open the Citect Computer Setup Wizard.
2. Check the Custom Setup option and click Next.

3. Make sure the correct project is selected and click Next.

4. Check the Server and Control Client option.
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5. You can also check the Multi-Process option if appropriate for the server setup.

6. Select the TCP/IP option.
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7. Depending on the server setting, check the Internet Server option or leave this in the 
default setting.

8. On the Alarm Server Properties Setup screen, set the Primary Alarms Server save path 
to C:\ProgramData\Schneider Electric\PowerLogic SCADA 7.20\Alarm.

9. Set the Standby Alarms Server save path to “<network drive>\Alarm” such as: 
“G:\Alarm”.

10. Other options can remain in the default values.
NOTE: If the Alarm folder is not already present in that directory the computer setup 
wizard is going to create one when the program is run.

11. Check the Inhibit triggered trends on startup option, if appropriate for the server setup.
12. Click Next until the Security Setup – Control Menu screen appears.
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13. Check the Kernel on menu option.

14. Click Next until the wizard completes. You can change default values, if necessary.
15. On the final wizard screen, click Finish. Citect will compile the project.

If the Alarms folder is not present in the “PowerLogic SCADA 7.20” folder, a message 
appears to confirm that you want to create a new folder in that directory.

Click OK to continue.

Repeat these steps on the secondary server.

Configuring PSE 7.30/7.40 Servers for Hot Standby Operation

1. Open the Registry Editor (Type Regedit into the Start Menu for Windows 7 or type Run 
if on an earlier OS).
a. Navigate to HKEY_LOCAL_MACHINE\SOFTWARE\Schneider 

Electric\ClearSCADA\OEMInfo.
b. Right-click, choose New->String Value, and add VendorName.
c. Right-click the entry, choose Modify Data, and enter Schneider Electric for the value 

data.
d. Repeat for ProductName and value data as PowerSCADA Expert 7.30 (or 7.40).
Your results should be:

• “VendorName”=“Schneider Electric”
• “ProductName”=“PowerSCADA Expert 7.30” or “ProductName”=“PowerSCADA 

Expert 7.40”

Ensure the following:

• Proper network addresses are in the project configuration file.
• There are no Connection Priorities for the Alarm Servers in the .ini file.
NOTE: Assigning connection priorities to Alarm Servers in the SCADA project may cause 
Hot Standby to fail in certain cases. To prevent this, do not add this Parameter to the 
Alarm Server properties in the .ini file.
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• Single Cluster per Alarm Server (per Hot Standby KB article.)
• SQL servers are configured for remote connections.

2. Run the Setup wizard as follows:
a. Open the Citect Computer Setup Wizard through the Citect Project Editor, check the 

Custom Setup, and click Next.

b. Make sure the right project is selected.
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c. Check the Server and Control Client check box. (Multi-Process can be checked based 
on the server configuration).

d. Check the Networked button.
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e. Checking Inhibit triggered trends on startup is optional (checked is recommended).

Everything can be left with the default values until you get to the General Options Setup 
page.

• Click Register.
• Navigate to C:\ProgramData\Schneider Electric\PowerSCADA Expert 7.30 (or 

\PowerSCADA Expert 7.40).
• Copy “system.xml”. 
• Back up one level (C:\ProgramData\Schneider Electric) and create a folder called 

ClearSCADA.
• Paste “system.xml” to this file (C:\ProgramData\Schneider Electric\ClearSCADA).
• Whenever network addresses for the primary and secondary machines change, 

delete both system.xml files, click Register again, and replace the system.xml file in 
the ClearSCADA folder.

• Make sure the “Primary Alarms Server save path” is set to 
C:\ProgramData\Schneider Electric\PowerSCADA Expert 7.30\Data (or 
C:\ProgramData\Schneider Electric\PowerSCADA Expert 7.40\Data) [If the Data 
folder is not already present in that directory the computer setup wizard is going to 
create one when the program is run].
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f. Click Next until you see the page with “Security Setup - Control Menu” and check the 
last option Kernel on menu.

g. Click Next, making any desired changes to other defaults, until you reach the end of 
the wizard and can finish the setup.

3. Repeat Step 2 on the Secondary Server.
4. Compile the project.
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Troubleshooting

Troubleshooting Citect Setup

Citect INI file settings

When you try to connect ENM with Citect, make sure these changes are made in the 
“Computer Setup Editor” under Citect Project Editor:

CtAPI

AllowLegacyConnections = 1

AllowLegacyServices = 1

LAN

AllowLegacyConnections = 1

Citect-Regkey entry

Verify the following registry key exist or can run the Citect-Regkey entry from the CD:

[HKEY_LOCAL_MACHINE\SOFTWARE\Citect\SCADA Installs] 
"ActiveINIPath"="C:\\Documents and Settings\\All Users\\Application Data\\Schneider 
Electric\\PowerLogic SCADA 7.10\\Config\\"

[HKEY_LOCAL_MACHINE\SOFTWARE\Citect\SCADA Installs\7.10] 
[HKEY_LOCAL_MACHINE\SOFTWARE\Citect\SCADA Installs\7.10\PowerLogic 
SCADA]

"DefaultINIPath"="C:\\Documents and Settings\\All Users\\Application Data\\Schneider

Electric\\PowerLogic SCADA 7.10\\Config\\citect.ini"

@="Citect"
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Active and Passive Cycling Messages in ENM Diagnostic Log

In certain cases, when Hot Standby Mode is enabled in ENM, the active machine may begin 
cycling between Active and Passive modes. The Active machine will briefly become Passive 
(for about 8 seconds) before being set back to Active. This will continue to occur until 
services are restarted or a failover occurs, causing states to change for real, rather than 
cycling.

This does not seem to affect the actual operation of the system, but rather it clogs up the 
Diagnostic Log, making it harder to see useful information. To prevent this, an option is 
included within Hot Standby that will “double-check” when this switch occurs and prevent this 
brief switching. As this does not occur all the time, the double-check is initially turned off, but 
it only requires one change in the configuration file to turn it on.

Turn on Double-Check

1. Open Windows Explorer and navigate to C:\Program Files\Schneider 
Electric\StruxureWare Solutions\HotStandby.

2. Open PlsHotStandbySvc.exe in Notepad or another text editor.
3. Scroll down in the Config file to:

<appSettings>

<add key="MinTimeToSwitchOverSeconds" value="10"/>

    <add key="DoubleCheck" value="false"/>

    <add key="VerboseDiagnostics" value="false"/>

</appSettings>

4. Change <add key="DoubleCheck" value="false"/> to "true".
5. Save file and close.
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6. Open Windows Services (Type services.msc into Start Menu or Run) and restart 
PLHotStandBy Service.

7. Repeat this process on the other Hot Standby machine.
Cycling between Active and Passive will now be prevented and Hot Standby will continue 
to operate as normal.



63220-083-04A2 
04/2014

© 2014 Schneider Electric All Rights Reserved 51

Chapter 8 — Custom Messaging

This chapter covers both standard and custom OPC attributes for defining messages.

Standard OPC attributes

You can replace the default [MESSAGE] value with other properties based on standard OPC 
attribute values. To define a message with other OPS attributes, enclose the OPC property 
names in brackets. Any text or character you add to the Message field will appear in the 
message. Other text outside of brackets will appear in the notification as written.

The OPC properties you can use in a message are:

• ACKREQUIRED – Acknowledge Required
• ACTIVETIME – Active Time (Event Time)
• ACTORID – Actor
• CONDITIONNAME – Condition Name
• MESSAGE – Message
• SEVERITY – Severity
• SOURCE – Source
• SUBCONDITIONNAME – Sub condition
• TIME – Server Time Stamp

Custom OPC attributes

You may also place the OPC custom attributes into the message by inserting the name of the 
attributes in brackets as you would a standard OPC property. For example, a custom attribute 
named “Milliseconds” could be inserted by including [Milliseconds] in the message template.

In addition to substitution, ENM supports special cases for “source levels” and “date 
formatting.”

Source Levels

The source field can be broken into levels so that only a specific level will be inserted. To 
insert a particular level use the SOURCE attribute, plus two parameters separated by the 
colon “:” character.

For Source: Parameter 2 is the Level, as in Level0.Level1.Level2.Level3

For Source: Parameter 3 is the character to use in splitting the source string for the levels

For example, [SOURCE:0:.] would determine levels based on the “.” character and insert the 
first level “0”.

If the SOURCE property is “Area1.Area2.Area3” then “Area1” would be inserted into the 
message where [SOURCE:0:.] existed previously.
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Date Formatting

Dates can be formatted using a second parameter containing a valid date format. To format a 
date, use the TIME or ACTIVETIME properties followed by a colon “:” character then the date 
format string. Date format strings provide a great deal of flexibility to return date and time 
information to the user.

For extensive information on date format strings, refer to the following Microsoft sites for 
standard formats.

http://msdn.microsoft.com/en-us/library/az4se3k1.aspx

An extended list for finer control exists here:

http://msdn.microsoft.com/en-us/library/8kb3ddd4.aspx

The commas, dashes, and words will appear between the inserted values as shown in the 
Message field. For Example:

[SOURCE:0:.], [CONDITIONNAME] - [ACTIVETIME:dddd], [ACTIVETIME:d] at 
[ACTIVETIME:T]

could return the following:

Alarm, True - Monday, 7/25/2012 at 11:39:54 AM
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Chapter 9 — DCOM Configuration

This chapter covers DCOM configuration procedures.

Setting Up a Remote Machine

To set up a remote machine with an OPC AE Server using DCOM, do the following:

1. In Windows, go to Start > Settings > Control Panel > Administrative Tools > 
Computer Management > Local Users and Groups.
a. In Users, create a user called DCOMUser. (In lieu of creating a new User, any user 

who has access to the local database will work. The built-in Administrator login would 
be ideal.)

b. In Groups, add DCOMUser, to the Administrative group.
c. Add the following to Distributed COM Users group:
• DCOMUser
• Administrator
• NETWORK
• INTERACTIVE
• NETWORK SERVICES
• SYSTEM
• SERVICE

2. Click Start > Run > DComCnfg.exe to run the DCOM configuration utility.
3. In the Component Services window, expand the Component Services node, the 

Computers node, and the My Computer node.

4. Right-click My Computer and choose Properties.
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5. Click Default Properties.

6. Set the options as follows:
a. Select Enable Distributed COM on this computer.
b. Choose Connect from the Default Authentication Level drop down list.
c. Choose Identify from the Default Impersonation Level drop down list.

Set the COM Security Options

Set options on the COM Security tab as follows:

1. Click COM Security.
2. Click Edit Default under Access Permissions.
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3. Click Add to add the group Distributed COM Users created in “Setting Up a Remote 
Machine” on page 53.

.

4. Check the boxes for all permissions for each group and user listed.
5. Click OK to apply changes.
6. Click Edit Default under Launch and Activation Permissions and do the following:

a. Click Add to add the group Distributed COM Users created in “Setting Up a Remote 
Machine” on page 53.

b. Check the boxes for all permissions for each group and user listed.
c. Click OK to apply changes.

7. Click Edit Limits under Access Permissions and do the following:
a. Check the box for Remote Access for each user and group listed.
b. Click OK to apply changes.
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Access Permissions

Set access permissions as follows:

1. Expand My Computer, select, and expand on DCOM Config.
2. Select OPCEnum server, a child node of DCOM Config, and right-click.

NOTE: This action may induce the addition of several registry keys. Be sure to click “OK” 
on the dialog boxes requesting acknowledgement.

3. Click General and choose Connect from the Authentication Level drop down list.

4. Click Security in the Launch and Activation Permissions box, select the Customize 
radio button, and then click Edit.

NOTE: The following steps may have automatically been completed.

a. Click Add to add the group Distributed COM Users created in “Setting Up a Remote 
Machine” on page 53.

b. Check the boxes for all permissions for the Distributed COM Users group.
c. Click OK to apply changes.

5. Repeat Step 4 for the Access Permissions and Configuration Permissions boxes.
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6. Click OK to apply changes.
7. Any OPC Servers present must also be configured in the same manner described in 

“Setting Up a Remote Machine” on page 53. These include:
• PLSEROPC AE
• PLS OPC AE/PowerSCADA Expert OPC AE
• PL TAG OPC AE
• Any other OPC servers

8. Repeat procedures in “Setting Up a Remote Machine” on page 53, “Set the COM Security 
Options” on page 54, and “Access Permissions” on page 56 for the second machine to 
enable DCOM and access to remote OPC servers.

Configure Firewall Settings

If the servers are also using a Firewall, follow these steps to add a rule to all ENM machines 
that need to be connected.

1. From Administrative Tools, open the Windows Firewall with Advance Security 
application.

2. Right-click the Inbound Rules node in the tree view and select New Rule.
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3. From the New Inbound Rule Wizard, select the Rule Type page.

4. Select Custom and click Next.
5. On the Program page, select All Programs and click Customize.
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6. On the Customize Service Settings dialog, make sure that Apply to all programs and 
services is selected and click OK.

7. On the Program page, click Next.
8. On the Protocol and Ports page, choose TCP for the Protocol type.
9. Choose Dynamic RPC for the Local port (DCOM uses the Dynamic RPC ports).
10. Choose All Port for the Remote port and click Next.

11. On the Scope page, select Any IP Address for the Local IP Address.
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12. Enter one of the following:
• The IP Address (recommended if only one machine is going to connect via DCOM). 
• Subnet or IP Address range (recommended if you have a number of machines that 

will connect via DCOM) of the machine(s) to be granted access.
or

• Any IP Address (recommended if you don’t care which machines connect via DCOM).
13. Click Next.
14. On the Action page, select Allow the connection and click Next.
15. On the Profile page, select the Domain option and click Next.
16. On the Name page, name your rule and click Finish.
17. If the rule appears as disabled, enable it.
If needed, restart for the settings to take effect.
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